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1.0 ABSTRACT

The Pusat Jagaan Graduan Ceria teachers and students are the target
audience for the MIKO IQ gaming application. With the help of the
internet and digital technology, this application offers interactive learning
platforms that are learner-centered. The Miko Iq Gaming Application
offers a platform where students may access math games and some
instructional films to speed up their learning. Additionally, the teachers
can utilise this programme to teach the pupils effectively and efficiently,
which will enhance the teaching process. For this project, the scripting
language utilised was Android Studio, acting as a communication bridge
between the back end and the users.As a result, this initiative has the
potential to significantly enhance both the learning and teaching processes
for both students and teachers at Pusat Jagaan Graduan Ceria in Simpang
Ampat.
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1.1 ) INTRODUCTION

The process of creating software for smartphones and digital assistants,
most frequently for Android and iOS, is known as mobile application
development. Nowadays mathematics become very hard subject to
understand by kindergarden students. Interactive computer games having
three-dimensional graphics—height, breadth, and depth—are referred to
as 3D games. It's thought that 3D gaming can produce an authentic,
immersive experience in android.

At the end of the project we able to present a IQ game application. The
reason of the proposed project is mainly for kindergarden kids with added
their syllabus in the application as aligned with PUSAT JAGAAN
GRADUAN CERIA .As the application games based on the KSSR
syllabus ,students may enjoy their lesson and improved their academic
level. As well we also have section for a general knowledge section to
explore .

We using Android Studio software to develop our application.Android
Studio is the free and open source . The official integrated development
environment (IDE) for creating Android applications is called Android
Studio. It integrates the code editing and developer tools from IntelliJ
IDEA, a Java integrated development environment for applications.

Android Studio employs a Gradle-based build system, emulator, code
templates, and Github integration to assist application development for
the Android OS. In Android Studio, every project contains one or more
modalities that include source code and resource files. These modalities
consist of Google App Engine modules, Library modules, and modules
for Android apps
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1.2) PROBLEMSTATEMENT

1) Students become boring to learn their subjects from textbooks and
this make them slow too in their studies.

2) The traditional learning approach is very expensive. The costs are
caused by the necessity to produce and distribute printed materials to the
students.

3) There are only few iq gaming application included with
kindergarden (mathematics) syllabus for free.
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1.3 ) OBJECTIVE

1. To develop an IQ gaming application in Mathematic through mobile.

2. 2. To be used as learning aids for the teachers.

3. To provide a 3D IQ gaming application that can helps students get
more knowledgeable in mathematic.
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1.4) SCOPE

This project is to develop a IQ gaming application with added
kindergarden syllabus especially for mathematics subject for students at
PUSAT JAGAAN GRADUAN CERIA,TAMAN BANDAR TASEK
MUTIARA, SIMPANG AMPAT, SEBERANG PERAI SELATAN,
PULAU PINANG.

1.5 ) USER SCOPE

A) Teacher : This application will be used by kindergarden teacher to
give extra exercise related to mathematics subject for the students.

B) Student: This application will be used by the students to learn and
obtain knowledge from the gaming application to do extra exercise
related to mathematics subject.

1.6) SYSTEM SCOPE

Users can intuitively control mobile devices thanks to system design that
mimics basic gestureslike pinching, swiping, and tapping. Children with
autism can play a variety of games on mobile devices, including visual
simulation games, auditory simulation games, and problem-solving
games that stimulate the brain especially in mathematics. It aspires to
address modern human needs by offering healing, education, and
entertainment games online.This project is develop for PUSAT JAGAAN
GRADUAN CERIA,SIMPANG AMPAT. The software we using for
develop the application is Andriod Studio.
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1.7 ) PROJECT SIGNIFICANT

The idea of project is called MIKO IQ GAME application and uses the
popular mobile technology we have today in our smart devices. that
enable users to finish tasks that train particular cognitive abilities such as
memory, attention span, reasoning, and quick thinking. Students should
play this IQ game since it will help them learn more from their textbooks
than they would otherwise. It's not the only reason to play games, but it's
an important factor in why they are so popular with youngsters.
According to parents, gaming can help kids master necessary but difficult
skills that they might otherwise refuse. As a result, we use IQ Games to
assist students in developing their skills. The way the study is presented.

This app's ability to distribute any learning resources quickly and
effortlessly is one of its main advantages for teachers. Research has
shown that incorporating games into the classroom can boost student
engagement, promote quicker social and emotional learning, and
encourage risk-taking. This makes it simpler for teachers and gives them
the opportunity to give students access to more learning resources. More
children will participate and learn more about what the teacher is trying to
teach because our app is an IQ game. Due to the abundance of study
material, it is quite simple for professors to post various topics to this app,
which students may then access.
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1.8 ) LITERATURE REVIEW

A useful IQ game and study program for pupils is MIKO IQ GAME. Due
to its capabilities, it will also offer helpful tools in a captivating setting. It
allows users to continue working while they are learning.

This section will cover comparisons and an explanation of the system that
will use similar techniques to the MIKO IQ GAME Application. The
system's quality will also be raised by the literature review by making
some further changes that will enhance the user experience in general.

MIKO : IQ GAME

MIKO:IQ GAME is simple as everyone can use this app. The IQ game is
different than other games. It’s not only same game as other.. MIKO: IQ
GAME will be kid’s favorite game because it’s colorful, attractive, easy
IQ Games, best sound effect and visual. It’s a mathematics IQ Game and
based on KSSR Kindergarden syllabus. This application is quick learning
phase and everyone can use it. Especially ads free. We inform children
progress by sending email to school and parents.

Kids Math : Math games for Kids

Parents should never start your child's education too early.
Toddlers, preschoolers, kindergarteners, older children, and others
are eager to learn the alphabet, numbers, addition, subtraction, and
other skills. Sharing clever, well-made educational apps and games
with children frequently is the greatest way to support that.

A free educational game called Math Kids is made to teach basic
math concepts to young children. It has a variety of mini-games
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that preschoolers and toddlers will enjoy playing, and the more
they play, the more their math abilities will advance. Preschoolers,
kindergarteners, and first graders can use Math Kids to learn how
to recognize numbers and begin practices addition and subtraction
problems. They'll love completing games and collecting stickers,
and you'll love seeing them develop and learn.

Strength
More likely to remember information when they are able to
play while they are learning. Additionally, it increases their
desire to learn, which will greatly benefit them when they
enter kindergarden .A number of features in Math Kids also
assist parents in managing and monitoring their children's
progress. You can adjust game settings to make them harder
or easier, or you can look at report cards to view the results
of past rounds. The ideal way to learn the fundamentals of
counting, addition, and subtraction is with Math Kids. In
addition to early mathematics, it will educate your toddler,
kindergartener, and first-grader sorting and reasoning skills,
laying the groundwork for a lifetime of study.

TheMoron

Moron is a brain teasers with simple, addicting gameplay and also
Puzzle games with six sections featuring hundreds of fun puzzle.
The memory games that test your cognitive capacity and also its
Logic games with tricky, unexpected twists. The Moron is a
Knowledge games where you have to (try to) think fast. Trivia
games let you flex your knowledge .The Shape puzzles to
challenge your spatial powers.

Strength
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Strength Puzzle games with funny characters, sound effects
and music. Global leaderboards of the smartest minds on
Earth!. Also High IQ achievements! We also have Low IQ
ones if that’s more your speed. Lastly, Fun casual games
with beautiful graphics. Lots of pictures just like in your
favorite books!

Toodler

Children in prekindergarten can play educational toddler
games. Our app's 15 preschool exercises for toddlers will aid
in the development of your child's fundamental abilities,
including hand-eye coordination, fine motor control, logical
reasoning, and visual perception. These games are
appropriate for both males and girls and can be taught to
children in preschool and kindergarten.

Strength
Size game: Understand differences in sizes by sorting
inventory into correct boxes.
123 game: Counting for toddlers to learn numbers 1, 2 and 3.
Puzzle game: A simple puzzle for kids to improve hand eye
coordination.



10

Logic game: Develop memory and logic with cute animals.
Shape games: Sort items by shape to develop visual
perception and hand eye coordination.
Color games: Sort items by color while riding on a train or
equipping a boat.
Logic game: Understand the purpose of the items shown.
Pattern game: Develop visual perception by sorting items
with different patterns.
Memory game: Choose correct object that was shown earlier
and fits others by its type.
Attention game: Develop attention and fine motor skills in a
simple but very entertaining game.

Preschool Learning Games-Fun

An educational app for toddlers and Pre-k kids. Children can
touch, hear, and experience counting, ABC, piano, music,
sizes, shapes and colors playing Kidz games.
Apart from basic learning and Preschool activities, the
Games4kids also focuses on the motor skills and hand-eye
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coordination enhancements for kids by multiple fun learning
activities and preschool games, based on the kinesthetic
learning process.

Strength
20+ interactive KIDS SAFE games for toddlers and
preschoolers for early childhood education. Beautifully
designed interactive Kids Games with colorful and
interesting cartoon characters. Great sound effects and
awesome animation.Help your kids learning ABCs, Colors,
Numbers etc. using educational activities for
children.Activities such as building cars and car racing help
to enhance the motor skills and hand-eye coordination
Engaging and fun educational games for kids from age 2 to 6.
Intuitive touch control specially designed for Pre-k and
kindergarten kids. Stickers at the end of each game.
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MIKO :
IQ

GAME

KIDS
MATH :
MATH
GAMES
FOR
KIDS

THE
MORON

TOODLER PRESCHOOL
LEARNING
GAMES FUN

DESCRIPTION It’s 3D A free
application educational

and game called
enable Math Kids
users to is made to
finish teach basic

tasks that math
train concepts to

particular young
cognitive children. It
abilities has a
such as variety of
memory, mini-games
attention
span,

reasoning,
and quick
thinking

Moron is a
brain
teasers
with
simple,
addicting
gameplay
and also
Puzzle
games
with six
sections
featuring
hundreds
of fun
puzzle

This app's 15
preschool
exercises

for toddlers
will aid

in the
development
of your child's
fundamental
abilities,
including
hand-eye

coordination,
fine motor
control,
logical

reasoning, and
visual

perception

An educational
app for toddlers
and Pre-k kids.
Children can
touch, hear, and
experience
counting, ABC,
piano, music,
sizes, shapes
and colors
playing Kidz
games.

3D YES NO NO NO NO

EASY LOGIN NO NO YES YES YES

BEST SOUND ,
VISUAL &
EFFECT

YES YES YES NO YES

ADS FREE YES NO NO NO NO
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1.8 ) METHODOLOGY

The research methodology adopted for this project is ADDIE Model

1

5

ADDIE is an instructional systems design (ISD) framework that many
instructional designers and training developers use to develop courses.[1]
The name is an acronym for the five phases it defines for building
training and performance support tools is Analysis, Design, Development,
Implementation, and Evaluation. This ADDIE Model help us to plan what
is next step of this project. The Analysis phase, Development Phase,
Implementation Phase and Evaluation Phase are all covered in this
chapter.

2

3

https://en.wikipedia.org/wiki/Instructional_systems_design
https://en.wikipedia.org/wiki/Instructional_systems_design
https://en.wikipedia.org/wiki/Instructional_systems_design
https://en.wikipedia.org/wiki/Instructional_design
https://en.wikipedia.org/wiki/Instructional_design
https://en.wikipedia.org/wiki/Training_and_development
https://en.wikipedia.org/wiki/Training_and_development
https://en.wikipedia.org/wiki/ADDIE_Model
https://en.wikipedia.org/wiki/Acronym
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Analysis

The analysis step defines the learning environment, the learner's current
knowledge and skills, and the instructional difficulties and objectives.
The analysis phase addresses a few specific topics, such as who the
learners are and what their features are, what the expected new behaviour
is, and what kinds of learning restrictions are present. plus more. These
inquiries are frequently made as part of a requirements analysis.
Instructional designers (IDs) identify resources and restrictions during the
needs analysis in order to properly fine-tune our action plan. We discuss
the problem statement of our project and gather all data from process
owner. Then analysis the software used to develop the project and discuss
the objective, scope of the project.

Design Phase
The design phase deals with learning objectives, assessment instruments,
exercises, content, subject matter analysis, lesson planning and media
selection. We decide our design phase to be systematic and specific.

Development Phase

The development phase of the project has finished with its current
iteration. Based on the research and design methods we used, we will
begin creating the application. The application will be created to meet the
needs of the user. For this project, we will be using the Blender software
to create the application, which will improve both the quality of student
learning and teacher instruction.

Implementation
Users will be able to access the application once the development phase is
through (teachers and students). The teachers and students of PUSAT
JAGAAN GRADUAN CERIA, Bandar Tasek Mutiara, Simpang Ampat,
Penang, will use this application.

Evaluation
To further enhance the project and the user experience, all ratings and
comments regarding the MIKO IQ GAME Application from users and the
project panel will be appreciated.
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1.9 ) GANTT CHART
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2.0 FUNCTIONALREQUIREMENT

Display

Content

All the contents (related to maths) are displayed in this project.

Interact with

Application

Students and Teachers are able to interact with the interface by

clicking on the respective contents.

Connection

with Database

This project is able to collect and push data/information received to

the database.
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2.1 NON-FUNCTIONALREQUIREMENT

Security The application is fully secured

Availability The application will always be accessible for the Teachers and

Students.

Maintainability The application cost-effectively over its usage, and can incorporate

additional requirements such as modifiability and configurability

Performance The application is designed and built with an acceptable standard of

performance.

Language The main language used in this application is English Language.
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2.2 HARDWAREREQUIREMENT

Hardware Description

Computer/Desktop For interacting with the programme

2.3 SOFTWARE REQUIREMENT

Based on table 2.2, it shows the software in detail used to develop thisapplication.

SOFTWARE DESCRIPTION

Operating System Window 10 10.0

Operating System
Architecture(VM)

OpenJDK 64-Bit Server VM by Oracle
Corporation

Programming Software Android Studio Chipmunk | 2021.2.1
Patch 2

Run Time Version 11.0.12+7-b1504.28-7817840 amd 64

GC G1 Young Generation, G1 Old Generation

Memory 1280 M

Cores 8

Registry external.system.auto.import.disabled=true,
ide.images.show.chessboard=true
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Compose Animation Preview

It is now possible for developers of Jetpack Compose to view and
troubleshoot the animations they created using Compose using this
formerly experimental capability. You can analyse the precise value of
each animated value at a certain time, pause the animation, loop it, fast-
forward it, or slow it down if it is specified in a composable preview.
Comparing animations to their design specifications frame by frame can
be extremely helpful.

AnimatedVisibility and updateTransition are presently supported by
Compose Animation Preview. In the future, it will support more sorts of
animation.
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CPU Profiler

In order to help you identify the true reason of a jank, Android Studio
Chipmunk now displays updated jank information, including jank types
and projected and real deadlines. When using an Android emulator or a
physical device with an API level of 31 (Android 12) or higher, you can
access this jank information.

Build Analyzer: Check Jetifier

In Chipmunk, we've added a new Jetifier check to the Build Analyzer that
will let you know if you can disable the Jetifier flag to speed up the build
process.

The bulk of Android Studio projects still have the Jetifier flag enabled
because it was created to automatically convert third-party libraries to use
AndroidX. Turning the option off will normally reduce build times by 5–
10%. However, the library ecosystem has largely switched to supporting
AndroidX natively, so having the flag now typically adds unneeded build
overhead.
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Visual Studio 2022 can be downloaded from this website:

2.4 System Configuration

ANDROID STUDIO 2021 CONFIGURATION AND SETUP

Android Studio 2021 can be downloaded from this website:

https://developer.android.com/studio?gclid=CjwKCAiAkfucBhBBEiwAFjb
kr6J9eQf8KgT1WEqHghDKoowu4K8zsSfrj8vg59y5qoEvXbCb_ppSTxoC
cTgQAvD_BwE&gclsrc=aw.ds

The wizards and templates offered by Android Studio allow you to select
default settings such as an optimal default Android Virtual Device (AVD)
emulation and up-to-date system images while also verifying your system
requirements, including the Java Development Kit (JDK) and RAM
availability. This page explains extra configuration options you could use
to tailor how Android Studio works for you.Android Studio provides
access to two configuration files through theHelp menu:

 studio.vmoptions: Customize options for Studio's Java Virtual
Machine (JVM), such as heap size and cache size. Note that on Linux
machines this file may be named studio64.vmoptions, depending on your
version of Android Studio.

 idea.properties: Customize Android Studio properties, such as the
plugins folder path or maximum supported file size.

Find your configuration files

Both configuration files are stored in the configuration folder for Android
Studio. The name of the folder depends on your Studio version. Here are
the locations for Android Studio 4.1 and higher:

Windows:

Syntax: %APPDATA%\Google\<product><version>

https://developer.android.com/studio/intro/studio-config
https://developer.android.com/studio/intro/studio-config


22

Example:
C:\Users\YourUserName\AppData\Roaming\Google\AndroidStudio4.1

Customize your VM options

You can modify the JVM's parameters in Android Studio's
studio.vmoptions file. The most frequent setting to change to boost
Studio's speed is the maximum heap size, but you can also change other
default values like the starting heap size, cache size, and Java garbage
collection switches using the studio.vmoptions file.

To create a new studio.vmoptions file or to open your existing one,
use the following steps:

Click Help > Edit Custom VM Options. If you have never edited VM
options for Android Studio before, the IDE prompts you to create a new
studio.vmoptions file. Click Yes to create the file.

The studio.vmoptions file opens in the editor window of Android Studio.
Edit the file to add your own customized VM options. For a full list of
customizable JVM options, see Oracle's Java HotSpot VM Options page.

The studio.vmoptions file you create gets added to the default
studio.vmoptions file, located in the bin/ directory inside your Android
Studio installation folder.

Note that you should never directly edit the studio.vmoptions file found
inside the Android Studio program folder. While you can access the file to
view Studio's default VM options, editing only your own
studio.vmoptions file ensures that you don't override important default
settings for Android Studio. Therefore, in your studio.vmoptions file,
override only the attributes you care about and allow Android Studio to
continue using default values for any attributes you have not changed.

Maximum heap size
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The maximum heap size in Android Studio by default is 1280MB. The
efficiency of Android Studio processes like the main IDE, Gradle daemon,
and Kotlin daemon can be improved if you are working on a large project
if your computer has a lot of RAM.

Android Studio automatically checks for possible heap size optimizations
and notifies you if it detects that performance can be improved.

A notification about recommended memory settings.

If you use a 64-bit system that has at least 5 GB of RAM, you can also
adjust the heap sizes for your project manually. To do so, follow these
steps:

Click File > Settings from the menu bar (or Android Studio >
Preferences on macOS).

ClickAppearance & Behavior > System Settings > Memory Settings.
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Adjust the heap sizes to match your desired amounts.
ClickApply.

If you changed the heap size for the IDE, you must restart Android Studio
before the new memory settings are applied.

Export and import IDE settings

You can export a Settings.jar file that contains all or a subset of your
preferred IDE settings for a project. You can then import the JAR file into
your other projects and/or make the JAR file available to your colleagues
to import into their projects.

Set the JDK version

A copy of the latest OpenJDK comes bundled with Android Studio 2.2
and higher, and this is the JDK version we recommend you use for your
Android projects. To use the bundled JDK, do the following:

Open your project in Android Studio and select File > Settings... > Build,
Execution, Deployment > Build Tools > Gradle (Android Studio >
Preferences... > Build, Execution, Deployment > Build Tools > Gradle on
a Mac).

Under Gradle JDK, choose the Embedded JDK option.

Click OK.

By default, the Java language version used to compile your project is
based on your project's compileSdkVersion (because different versions of
Android support different versions of Java). If necessary, you can override
this default Java version by adding the following compileOptions block to
your build.gradle file:
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android

{ compileOptions

{

sourceCompatibility
JavaVersion.VERSION\_1\_6

targetCompatibility
JavaVersion.VERSION\_1\_6

}

}



26

3.0 FINAL DESIGN
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4.0 DISCUSSION

4.1 ADVANTAGES OF THE PROJECT

This Miko IQ Gaming Application is fully adjusted and designed to
accommodate the needs of the Teachers and Students in Pusat
Jagaan Graduan Ceria ,Simpang Ampat.

Additionally, this Miko IQ gaming application is reasonably priced.
The Kindergarten was able to reduce the price by making
significant financial savings. This is due to the fact that teachers
must regularly purchase and print a tonne of learning materials
(related to arithmetic) for the kids. The fact that this programme
may be used by both students and teachers for free means that it
saves a lot of money compared to printing and purchasing
instructional materials.

Additionally, it is well established that online education, or e-
learning, has a beneficial effect on education. As a result, using this
programme enables users to improve their capacity for learning and
apply acquired math skills.It helps one retain information for
extended periods of time, which is another benefit.

Secondly, the consistency of instruction is improved by this Miko IQ
gaming application. This is due to the fact that teachers in the traditional
learning technique not only have a limited amount of time to teach their
students, but are also prone to making mistakes. Therefore, by offering the
kids standardised and consistent instruction, these problems are ensured to
be resolved using this programme. With the help of our Miko IQ gaming
application, teachers may deliver their lectures consistently and guarantee
that every student learns the same amount of information.
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5.0 LIMITATIONS OF PROJECT

The time required to finish the entire project is one of its drawbacks. This
is due to the fact that we had just 14 weeks to finish the full project, which
included the phases of analysis, design, development, implementation,
and evaluation.

On the other side, we were able to access the database directly and view
the PDF notes. For instance, users are unable to read PDF files once they
have been uploaded to the database. Users can only access it as a result by
surfing from their smartphone.
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6.0 CONCLUSION

In conclusion, the goals set forth in the development of this Miko IQ
gaming application have been achieved.

The creation of this application will support and assist students who
struggle with especially mathematics by assisting and guiding them. It
will open up new opportunities for teachers and parents to support these
kids throughout their formative years. It is hoped that this project would
succeed if it is able to achieve all of its objectives and address the issues
raised before. That can help the children of slow learners develop more
effectively.

At Pusat Jagaan Graduan Ceria in Simpang Ampat, this Miko IQ gaming
application will be essential to improving both the students' and teachers'
quality of instruction. The primary goal of this project is to create a
mobile IQ game application for math. and get them used to using this
programme where math learning resources are readily available. It is a
cheap, effective, and cosy method for students to quickly retrieve notes.
The execution of this initiative benefits teachers and students alike.
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